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Welcome to Your Excel Introduction Training Course 

 You will feel more confident using Excel and be able to create a 

spreadsheet from scratch. 

 Understanding built in calculation and formula functionality will allow you 

to be more productive in your work and home Excel environments. 

 Spreadsheets that you create will be easier to use and look more 

presentable. 

 You will be able to present your data visually using charts and Sparkline’s 
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Unit 1: Getting Started 

In this unit you will learn how to: 

 What Microsoft Excel is 

 How to open Microsoft Excel 

 How to interact with Excel 

 How to close Excel 

 How to create a new workbook 

 How to open a workbook 

 How to close a workbook 

 About the active cell 

 How to select cells 

 How to use the Help screen 

 

 Opening Microsoft Excel 
There are a number of ways to open the Excel program. First, look for the Excel 

icon on your desktop ( ) and double click it. The Excel screen should open for 

you. 

 

If you cannot find the Excel icon, click the Start button on the bottom left corner 

of your desktop to display the Start menu, then choose: 
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Programs/All Programs  Microsoft Office  Microsoft Office Excel or Microsoft 

Office Excel 2016  

Interacting with Excel 
Once you open Excel, you should see an Excel screen (also called a user interface) 

like the one shown below. 
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Columns, Rows, Cells, and Ranges 
Columns, rows, and cells are the most fundamental components of a work sheet. 

A column is a vertical series of adjacent cells from top to bottom. A row is a 

horizontal series of cells from left to right. A cell is a single rectangle anywhere in 

the grid area of a worksheet. 

 

 

 

The Active Cell 

Every cell in your spreadsheet has a name or reference that can be formed by a 

letter-number combination, e.g. A5, D6.  

When you select a cell in an Excel worksheet, it becomes enhanced with a thicker 

border. The cell you have chosen is now the active cell, and its name or reference 

is the cell column letter followed by the cell row number. In this image, cell G4 

is the active cell. 

The column letter and row number of the active cell are displayed in the Name 

Box near the upper left corner of the Excel grid.  

The active cell is G4 
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If you enter text or numbers into the Formula Bar (shown below), the text or 

number that you type will also be entered into the active cell.  

 

Selecting Cells 

To select a group of cells, place your mouse pointer in the centre of a cell. When 

the pointer turns into a thick white shaded cross, hold the left mouse button 

down and drag the pointer across the row or down the column of cells you want 

to select. In this image, the cells B1 to B4 have been selected. 

The Ribbon 

This part of the Excel interface is what allows you to control, format, and edit the 

data stored in the Excel grid area of the spreadsheet. This is also where the tools 

that help you analyse, interpret, organise, and present your data are found. Each 

ribbon is separated into groups with the group name shown at the bottom. Each 

group contains buttons which can be used as tools to performing functions, e.g. 

in the 'Home' ribbon below, examine the 'Font' group. Use these buttons to 

change some types of formatting of the contents of a cell. 

If you left click one of the labeled tabs above the Ribbon (Home, Insert, Page 

Layout, Formulas, Data, Review, View), you will see the buttons and controls in 

the Ribbon change according to the tab you click on. 
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If you let your mouse pointer hover on a button or control, you will see a shaded 

box appear. This box, also known as a 'Screen Tip', will show you the name and a 

brief description of the button or control in question. 

 

The Quick Access Toolbar 

The Quick Access toolbar is located at the top left of the Excel window (to the 

right of the Excel Logo) and contains by default three buttons, namely, Save, Undo 

and Redo. The purpose of this toolbar is to provide you with quick access to 

buttons which may not be on any of the ribbons.  

There are three ways to add more buttons to the Quick Access toolbar: - 

1. Click the drop-down arrow on the right hand side of the Quick Access 

toolbar and select whichever buttons you desire to use. 

2. Right-click any button on one of the ribbons and click 'Add to Quick 

Access toolbar'. 

3. Click the drop-down arrow and select 'More Commands' 

a. Select a button from the left-hand panel and click 'Add' or double-

click to place the button into the Customise Quick Access toolbar 

section. 

b. Buttons can be re-arranged by using the up/down arrows on the 

right 
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The Quick Access toolbar can be shown above or below 

the ribbon. The File Menu (Backstage) 

You can display the 'Backstage' menu by clicking File Tab 

on left of the screen.  

Creating a New Workbook 

Once Excel is open, you can create 

additional new workbooks by clicking on 

the File Tab and clicking the 'New' button 

then click 'Create'. 

You can also create a new workbook by 

using the shortcut keys Ctrl + N. 

Opening a Workbook 

To open a workbook, display the File > Backstage menu and either: 

 Choose Open or 

 Choose a workbook from the Recent Documents list. 

 You can also use the shortcut keys Ctrl + O. 
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Closing a workbook is different from saving a workbook. If you have not made 

any changes to the workbook, just left click the lower X in the upper right corner 

of the workbook. 

Close workbook 

Closing Excel 

To close Excel and all open Excel files, click the top X in the upper right corner of 

the Excel screen.  

 Close Excel program 

Excel 2013 & 2016 only have one X in the upper corner 

Using the Help Screen 
If you find that you need help with a given topic in Excel, you can access the Excel 

Help Screen by clicking on the question mark button in the upper right corner of 

the Excel screen.  

You can also display the Help Screen by pressing F1 on your keyboard.  
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Unit 2: Entering and Editing Data 

In this section you will learn how to: 

 Create worksheet labels 

 Enter and delete data 

 Use the AutoFill feature 

 Use AutoComplete 

 Work with basic formulas 

 Save an Excel workbook 

Entering and Editing Data 
Now that you understand the basics of columns, rows, ranges, and labels, it is 

time to start working with data. One way to enter data into an Excel worksheet is 

to click on the cell you want to use (making it the active cell) and enter the 

information directly into it. When you type something in the active cell, what you 

type will also be displayed into the formula bar.  

If you type text, numbers, or formulas 

in the Formula Bar and press Enter, 

the data or formula you typed will be 

entered into the active cell. When 

you enter data in the formula bar, 

you will see an X and a check mark 

next to the data entry field. If you 

click the X (cancel), the data in the 

formula bar will be cleared. Clicking 

the check mark will enter the data 

just like pressing the Enter key. 
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Handy hint: 

Values should be entered in without currency symbols or commas as these can be 

applied using number formats later on. 

Using Undo and Redo 

Anyone can make mistakes, especially when creating a complex worksheet. Excel 

provides a way of backtracking over, or undoing incorrect or unintended actions.  

To undo an action, click the Undo button on the Quick Access Toolbar. This will 

undo the very last action you performed. The shortcut combination of CTRL + Z 

performs the same action. 

 

If you want to redo an action (perform an action that you undid with Undo), you 

can click the Redo button on the quick access toolbar. 

 

You can also click the downward pointing triangle to show a list of recent actions. 

You can select actions from this list and then click the selected item to delete it 

and any other actions above it in the list. 
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Editing labels and values 

There are various ways to edit (make changes to) labels and values that have been 

entered into a spreadsheet. 

The Formula Bar can be used to edit the contents of a cell. Select the cell to be 

edited, and click in the formula bar to edit. 

 

To edit directly inside a cell: 

 Double-click directly on the cell and use the arrow keys or click to move 

the cursor 

 Press the F2 key – the cursor appears at the right end of the cell contents 

AutoFill and AutoComplete 
When working with spreadsheets, it is often the case that you must repeat data 

in a large number of cells. Excel helps you do this efficiently by automating some 

basic and repetitive tasks for you.  

Using AutoFill 

The Fill handle is a useful tool in Excel. Positioning your cursor over the bottom-

right corner of the active cell brings the Fill handle up on your screen. 

 

 

The Fill handle can be used to quickly enter: 

 Quarters (Quarter 1, Quarter 2 etc.) 

 Days of the week 

 Months of the year 

What is AutoComplete? 

AutoComplete will help you enter data by completing what you type, based on 

similar data in adjacent cells in the same column. If you enter the name John in a 

cell, and then type the letter J in the cell immediately below it, AutoComplete will 

The Fill handle 
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fill in the letters 'ohn' completing the word John. You simply need to press Enter 

to accept the substitution. If you have two words with the same first letter in a 

column of adjacent cells, John and 

Jack for example, and you type a J, 

AutoComplete will wait until you type 

a second letter to discern the most 

likely match to complete the entry.  

Deleting and replacing data 

To clear cell content: 

 Select a single cell or range of cells and press the Delete key; or 

 Right-click on the cell and select the Clear Contents option 

To replace the contents of a cell: 

 Select the cell and begin typing - or 

 Use Find and Replace to make the same replacement multiple times  

(On the Home Ribbon – Editing group – Find and Select button - Replace 

or Ctrl + H)  

FlashFill 
Excel notices patterns in the user's data entry and then auto completes the 

remaining data so there’s no need to use formulas or macros to do this. Data gets 

filled in automatically. Flash Fill is like a data assistant that quickly finishes your 

work for you! 
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For example the Flash Fill feature will automatically complete a list of surnames 

after starting to type the second surname.  It recognises patterns and predicts 

what data to fill in for you.  Start typing the initials and Flash Fill fills the list for 

you. 

Flash Fill also recognises text case. After typing a name in upper case, clicking 

Flash Fill on the Data Ribbon fills all the rest of the names in upper case. 

Using Formulas in Excel 
Formulas are used to perform calculations in a spreadsheet, including addition, 

subtraction, multiplication and division. 

The main advantage of using formulas is that unlike a value that stays the same 

unless you edit it, the result of a formula will automatically recalculate itself in 

response to values in the spreadsheet being changed. 

Formulas can be easily recognised in a spreadsheet as all formulas begin with an 

equals sign =. 

Basic Mathematical Operators 

To build formulas in Excel, you will have to use the basic mathematical operators 

as shown in the following table. 

 

 

 

 

Order of calculations – BEDMAS or BODMAS 

In formulas where there is more than one operator, for example, an addition and 

a multiplication, Excel will not necessarily calculate the result by reading the 

formula from left to right. 

Excel will follow a set rule for the order in which it performs calculations. BEDMAS 

or BODMAS are acronyms you can use to help you remember the order in which 

Excel will perform calculations. 

Letter Stands for Calculation order 

( ) Brackets ^ Exponent 

+ Addition * Multiplication 

- Subtraction / Division 
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B Brackets 1st 

E or O Exponents or Order 2nd 

D Division 
3rd 

M Multiplication 

A Addition 
4th 

S Subtraction 

Formula Formula result would be: 

 

 

 

 

Saving a Workbook 

One way to save an Excel Workbook is to 

choose the Save As option from the Excel 

Office menu.  

Another way to save your workbook is to 

click the Save button  on the Quick 

Access toolbar. 

You can also use the shortcut keys Ctrl + S 

About Excel File Types 

Excel 2016, 2013, 2010, and Excel 2007 use the same file types which are different 

from the file types of previous versions of Excel. You should have no problems 

using Excel to open and work with files created with earlier versions of Excel. 

When you are saving a workbook file with Excel 2013 or Excel 2016, you can 

specify Excel 97-2003 Workbook as the file type by using the Save As type drop 

list in the Save As dialogue box. This can be helpful if you are worried about 

compatibility with earlier versions of Microsoft Office.  

Unit 3: Modifying a Worksheet 

In this section you will learn how to: 
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 Move and copy data 

 Move and copy formula 

 Identify relative and absolute references in a formula 

 Create an absolute reference in a formula 

 Inserting and deleting ranges 

 Use Smart Tag options 

Moving and Copying Data 
Moving involves physically transferring data from one location to another, 

whereas copying refers to duplicating data so that it appears in more than one 

location. 

Dragging and Dropping Cells 

To move data from one cell to another using your mouse: 

 Select a cell by clicking on it, making it the active cell. 

 When you see the thick black border around the cell, move your mouse 

pointer over one edge of the border. You will see your pointer turn into a 

four-headed arrow. 

 Hold your left mouse button down and drag the cell contents 

to a new location. 

If you select a group of cells, the selection will be surrounded by a thick black 

border. You can mouse drag a selection by grabbing this border, just as you 

dragged a single cell. 

How to Cut, Copy, and Paste Cells 

By right-mouse click: 

 Select the data, then right-click for cut and copy options 

 Select the destination cell for the data, then right-click for the paste option 
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Using the Clipboard group 

The clipboard button group is at the far left of the Home 

Ribbon.  

This group of buttons relates to the tasks of cutting, 

copying, and pasting items from one location to another. 

The clipboard is the place where copied items are stored until they are needed.  

 

Paste Buttons 

 

 

The Paste button will paste the most recently cut or 

copied item from the clipboard to the location 

starting at the active cell. Items on the clipboard can 

be text, numbers, cell selections, and more. The 

clipboard can store up to 24 copied items. (Shortcut 

key: Ctrl + V) 

The bottom paste button (with the small down 

pointing arrow) will display a menu of paste options 

when clicked. 

Cut Button 

 

 

This button will remove the selected item from its 

original location and place it on the clipboard for 

future use. (Shortcut key: Ctrl + X) 

Copy Button 

 

 

This button will copy a selection or other item from 

the spreadsheet to the clipboard. Unlike cut, copy 

will not remove the selection or item from its 

original location in the spreadsheet. (Shortcut key: 

Ctrl + C) 
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When you cut or copy items, they are saved to the 

clipboard.  

You can view the items on your clipboard at any 

time by clicking the Home tab to display the Home 

Ribbon, and then clicking the small arrow at the 

bottom right of the clipboard button. 

You can clear all the items from the office clipboard by clicking the Clear All 

button, or you can paste all of the items on the clipboard by using the Paste All 

button. 

Moving and copying formulas 
In order to understand what happens when formulas are moved or copied, it is 

important to know about relative cell references and absolute cell references and 

understand how each type of reference behaves in a formula when moved or 

copied. 

Relative cell references 

In Excel, a specific cell can be named or referred to with a cell reference. A simple 

cell reference is just the letter at the top of the cell’s column, paired with the 

number at the left of the cell’s row. Cell A1, for example, is the first cell in the top 

left corner of the Excel grid (first column letter, A, and first row number, 1). 

 

In the image above, Cell A2 contains the value 500 while cell B2 contains the value 

250. Cell C2 contains a formula (=A2+B2, visible in the formula bar) that adds 

these two numbers by using their respective cell references. 

If you use your mouse to drag the cell containing the formula (C2) down to fill 

part of the column (using the Fill handle), you will see zeros in the cells that you 

drag the formula to. 
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You should also notice that the 

formula for cell C8 (the active 

cell) can be read from the 

formula bar as =A8+B8. But 

remember, the original formula 

in C2 (the cell we filled from) 

was =A2+B2. The formula has 

changed to reflect the relative 

positions of the cells. The 

formula in cell C2 adds the two 

cells to its immediate left. Each cell that this formula has been filled to, will contain 

a formula that adds the two cells to its immediate left. 

In other words, the formula adopts cell references that are relative to its position 

in the worksheet. This maintains the same relative positioning of the original 

formula. This results in zeros in the locations where the cells to the immediate left 

of the formula are empty.  

This is called a relative cell reference, meaning that if the formula is copied 

(dragged, filled, or copied) the cells involved will change to reflect the formula’s 

new position. 

Absolute cell references 

In the example below, we have mouse 

dragged a formula with absolute 

references to fill the six cells beneath 

it.Notice that this time, the value of 

750 is in each cell, and the formula 

contained in the active cell, C8, 

contains dollar signs. These dollar 

signs tell Excel that the references in 

the cell are absolute: no matter where 

the formula is copied or filled to, it will 

always use the same cell references.  
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The original formula at cell C2 is =$A$2+$B$2. When this formula is copied or 

dragged or filled anywhere on the worksheet, the formula will retain the same 

cell references because they are marked with dollar signs. 

You can create an absolute reference by pressing the F4 key once, immediately 

after the cell reference has been entered into the formula. 

Inserting and Deleting Ranges 
Quite often once you have created a spreadsheet you will want to modify it by 

adding or deleting rows or columns of data. 

Inserting cells, columns, and rows 

To insert a column in a worksheet: 

 Click the Insert option from the menu. A new column is inserted to the left 

of the selected column or right-click on the letter at the top of the column. 

A drop down menu will be displayed. 

This procedure is essentially the same 

for inserting rows. To insert a row, just 

right-click on the row number and 

choose Insert from the menu. A new 

row is inserted above the selected 

row. 

Deleting columns and rows 

To delete a column, right-click on the letter at the top of the column and choose 

'Delete' from the drop-down menu. 

To delete a row, right-click on the number at the left of the row, and choose 

'Delete' from the drop-down menu. 

The Cells group on the Home Ribbon 

also gives you control over inserting 

and deleting a cell or group of cells. 
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Unit 4: Using Functions 

In this section you will learn how to: 

 Identify common functions 

 Insert a function into a formula 

 Use the SUM, AVERAGE, MAX, MIN and COUNT functions 

What are Functions? 
In Excel, a function can be described as a built in tool for performing 

mathematical or logical tests. Quite often, you may need to perform operations 

in your worksheets that involve many cells, like totaling a lengthy column of 

numbers or averaging a large group of data. Excel’s functions can help you with 

these tasks. 

Excel has a wide range of functions. For example, you can use functions to find 

totals, averages, counts, minimum (smallest) and maximum (highest) amounts.  

SUM  Calculates the sum for a range of cells. 

AVERAGE   Returns the average for a range of numbers. 

MAX  Returns the largest number from a range of numbers. 

MIN Finds the minimum number in a range of numbers. 

COUNT   Will count the number of cells in a list that contain numbers. 

Using AutoSum 
It is often useful to have totals or sums for the rows and columns of numbers in 

your worksheet. AutoSum can easily add all of the numerical data in a column or 

row.  

 Select the cell immediately below the column of data (or immediately 

beside the row of data) 
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 Click the Formulas tab 

 Click AutoSum* button in the Function Library group. 

 The column or row of data to be summed will now be enhanced by an 

animated border. Notice that you can see the range to be summed in the 

active cell. 

 Press Enter and the total will be displayed in the cell. 

* The AutoSum button can also be found on the 'Home' ribbon in the 'Editing' 

group 
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The Function Library 

Excel contains an extensive library of functions that you can call upon to help you 

solve problems. These tools are available in the Function Library button group, 

on the Formulas ribbon.  

The first and largest button is Insert Function. This button will open a dialogue 

box allowing you to search for and insert hundreds of functions.  

You can also click the small fx button next to the formula bar to display the Insert 

Function box. 

 

Clicking the Insert Function button activates the Insert Function dialogue box and 

provides access to the large range of functions available in Excel. 

 

Once the Insert Function dialogue box is open: 
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 Select the function you wish to use from the available list and click OK or 

 Type the name of the function you wish to use in the Search for a function 

area, press Enter, select the function when it appears in the list and click 

OK. 

In the Function Arguments dialogue box, click the top button with the red arrow, 

then select the range of cells to enter into the formula from the spreadsheet, click 

OK. 

 

Using the AutoSum dropdown list 

The AutoSum button dropdown arrow provides access to common functions, and 

the Insert Function dialogue box. 

To insert a function using the AutoSum list: 

 Select the cell where the formula is to appear 

in the spreadsheet 

 Select the function you wish to use from the 

AutoSum list 

 Check the formula to ensure it is accurate – edit 

the formula if necessary 

 Press Enter to confirm the formula and display 

the formula result. 
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Entering functions manually 

All the common functions follow the same basic structure: 

=function_name(cell:cell) or =function_name(cell,cell,cell) 

Therefore, formulas containing functions can be typed directly into a cell in the 

spreadsheet. After pressing the = (equals button) start typing a function name. 

Immediately after entering the first character of the name, Excel provides you with 

a list of function names beginning with that letter. Locate the function name you 

require and double click on it. Excel will then insert the name together with the 

opening bracket. All you then have to do is to complete the function 

requirements and press enter. The closing bracket is automatically inserted for 

you and the result of the formula is entered into the selected cell. 

Using AutoCalc 

The AutoCalc feature in the status bar at the bottom-right of the Excel window 

can be used to find the result of using particular functions on cells that have been 

selected in the spreadsheet. 

To use the AutoCalc feature: 

 Select the range of values that you 

wish to find the 

total/average/minimum/maximum/count 

of 

 Right-click in the status bar and 

choose the relevant function(s) from the 

menu to view the result in the status bar 

area. 
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Unit 5: Formatting Worksheets 

In this section you will learn how to: 

 Apply font formats to a worksheet 

 Alter alignment 

 Apply number formats to a worksheet 

 Add patterns and colour to a worksheet 

 Add borders to a worksheet 

 Change column width and row height 

The Home Ribbon 
 

 

Common formatting features can be found in the Font, Alignment, Number, 

Styles, Cells, and editing groups on the Home Ribbon (above). 

Font 

The font button group lies on the Home Ribbon next to the clipboard group. 

These buttons allow you to change a font’s type, 

size, color, and style. The following table provides 

a brief description of the functions of these buttons 
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The Font Face 

Button 

 

 

This button allows you to 

change the type of font. 

Clicking the small down 

pointing arrow will allow you 

to select from a large list of 

available fonts. The scroll bar 

at the side of the font list will 

allow you to view all of the 

fonts available. 

 

The Font Size 

Button 

 

 

Use this button and its associated list of sizes to change the 

font size. You can also enter a size directly by clicking on 

the area that displays the current size and then entering a 

new number. 

Increase And 

Decrease Font 

Size Buttons 

 

 

These buttons will increase and decrease the font size of a 

selected cell or cells by increments of one from size 8 to 12 

and thereafter in increments of 2. 

Bold, Italic, 

and Underline 

Buttons 

 

 

These buttons will apply bold, italicized, or underlined 

effects to a cell or selection of cells. 

Borders 

 

Clicking the small arrow on this button will display a list of 

borders that you can apply to a cell or selection of cells. 
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Fill Color and 

Font Color 

 

The fill color button (paint bucket) will fill the background 

of a cell or selection of cells with the specified color. The 

arrow next to the button displays a palette of color options. 

The font color button (letter A) will color the text in a cell or 

selection of cells with the color that is specified. The arrow 

will display a palette of color options. 

Font Group 

Button 

 

Clicking the small arrow at the right of this button will 

display the font tab of the Format Cells dialogue box, which 

provides numerous options related to cell formatting. 

Alignment 

The buttons in the alignment group control how data (text or numbers) appears 

in spreadsheet cells. 

The following table provides brief 

descriptions of the alignment buttons. 

Horizontal 

Alignment 

 

 

The Align Left button will align the data in a cell or a 

selection of cells to the left edge of the cells. The Align 

Center button will align cell data in the center of the cells. 

The Align Right button will align cell data to the right edge 

of the cells. 

Decrease and 

Increase 

Indent  

 

These buttons will increase or decrease the amount of 

indent for the data in a cell or group of cells. The button 

with the left pointing arrow decreases the indent, while the 

button with the right pointing arrow increases the indent.  

Vertical 

Alignment

 

These buttons align your data relative to the top, middle, 

and bottom of the cells.  
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Text 

Orientation 

 

This button will rotate the text in a cell to various positions. 

Wrap Text 

 

If there is too much data for the length of a cell, the wrap 

text button will display the data on multiple lines so that it 

is visible. 

Merge and 

Center  

 

This button will merge multiple selected (empty) cells into 

one larger cell. Data in the new large cell will be centered. 

 

Alignment 

Group  

 

Clicking the small arrow on this button will display the 

alignment tab of the Format Cells dialogue box. 

Number 

The number button group controls how numerical values 

are displayed in cells. In Excel, numbers can have different 

formats including general (no specific format), number, 

currency, accounting, short date, long date, time, 

percentage, fraction, scientific and text. 

 

Let’s take a look at each command in this group. 
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Number Format 

List

 

 

Use this list to choose what format will be applied to a cell 

or selection of cells.  

Currency, 

Percent, and 

Comma  

 

Use these buttons to select a type of currency, a percent, 

or a comma separated number format for a cell or group 

of cells. 

 

Increase/Decrea

se Decimal 

Places 

 

These buttons will increase or decrease the amount of 

decimal places shown for a cell or selection of cells. 

Number Group  

 

Clicking the small arrow at the right of this button will 

display the Number tab of the Format Cells dialogue box. 

Format Painter 
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The Format Painter button on the Clipboard group will copy a specific format 

from one area, which can then be applied to another area. For example, you can 

select a group of cells and then click the format painter button to copy their 

format. You will then see a small paint brush next to your mouse pointer. When 

you select another different group of cells, the copied format will be applied 

(painted) to them. 

If you wish to apply the same formatting to different sections of your spreadsheet 

using Format Painter, then you must first select the formatted cell/s, double-click 

the button and then click on whichever cells require changing. When you have 

finished, clicking the Format Painter button or pressing the Escape key will release 

Format Painter. 

Changing the Size of Rows or Columns 
To change the size of a column, place your mouse pointer on the line that divides 

the column letters at the top of the column you want to change. For example, if 

you wanted to change the size of column B, you would place your mouse pointer 

on the line separating B and C. Your mouse pointer will turn into a vertical line 

with a small arrow on either side. 

 

 

 

When you see this pointer you can change the column size by holding the left 

mouse button and dragging the column edge to the left or right. Also, when your 

cursor is in this position, double-clicking will automatically change the column 

width to match whichever cell contains the most data. 

To change the size of a row, place your pointer on the line separating the row 

numbers at the left of the worksheet. When you see the pointer with a vertical 

line and an arrow on either side, drag the edge of the row to change the size.  
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Unit 6: Printing Workbooks 

In this section you will learn how to: 

 Use Print preview 

 Use the Print dialogue 

 Use the Page Setup dialogue 

 Use Quick Print 

Working with Print Preview 
Print Preview allows you to view how your spreadsheet will look when it prints, 

before printing it off. 

Opening Print Preview 

To open Excel’s Print Preview screen, either click the 'Print Preview' button on 

your Quick Access Toolbar or click the 'File' menu and click the 'Print' section in 

the Backstage area. This will display the Print button, Printer selection button and 

a Settings area. 
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From the 'Settings' area you can choose the following settings: 

What to Print 

 

Pages to Print 

 

Collated Style 

 

Paper Orientation 

 

Scaling 
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Using Page Setup 
Here’s what the Page Setup dialogue looks like. 

The Page tab 

Under the Page tab, you can change page orientation (portrait or landscape), 

print scale, paper size and print quality settings. 

The Margins tab 

Under the Margins tab, you can specify 

how to centre your page (horizontally or 

vertically) and you can directly enter 

values for the margins in the fields 

provided. 

 

The Header/Footer tab 

Under the Header/Footer tab, you can choose headers and footers that will be 

visible on the top (header) and bottom (footer) of each printed page. You can 

select preset headers and footers by clicking on them in drop lists located 

beneath the header, and above the footer, preview fields. 
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If you click the Custom Header or Custom Footer buttons, you will see a dialogue 

box like the one shown below. 

You can use this box to 

design a custom header 

by entering text in the 

provided fields. You can 

also format the text and 

enter page numbers, 

dates, and times by 

using the buttons above 

the text fields. 

 

 

The Sheet tab 

Under the Sheet tab you will find a control that will let you define a Print Area (a 

selection of cells from your workbook). If you define a Print Area, this is what Excel 

will print by default from the sheet if the Print button is clicked. 

Printing options 
In Excel, you have the option to produce hard copies of your spreadsheet with or 

without changing print settings prior to printing. 

Quick Printing 

If you click the Quick Print item on the Quick Access Toolbar, you will immediately 

send your workbook to the default printer, with no special formatting or page 

setup. 

Quick printing is also quite appropriate for small selections or ranges from a 

larger spreadsheet. You can select a print region (a selection of cells) by dragging 

your mouse and then click Quick Print. When you do this, only the region you 

selected will be printed. 
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Unit 7: Working With Charts 

In this section you will learn how to: 

 Create a chart in Excel 

 Modify a chart 

 Enhance a chart using various chart formatting features 

Creating a Chart 
Excel provides a series of chart buttons and controls on the Insert Ribbon. 

 

Before you create a chart, first consider the type of chart that you require. Pie 

charts and bar charts are good for showing comparisons. Line graphs can be 

useful for showing trends and plotting relationships between variables. If you 

want a really visually interesting chart, consider 

a three dimensional type.  

To create a chart: 

 Select the data that you want to base 

your chart on. 

 Select the Insert tab to display the Insert 

Ribbon. 

 On the Insert Ribbon, click the relevant 

chart type button to show a menu of 

various ways to display your chart. 

Manipulating a Chart 
Once the chart has been created, there are a number of ways in which it can be 

manipulated. 
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Moving and resizing a chart 

Sometimes it may be necessary to resize or even move your chart around in your 

spreadsheet. To do this, first single click in the chart area to display the chart area 

border. 

If you place your mouse pointer on the corner of the chart border and let it hover, 

you will see your pointer turn into a double headed arrow. If you drag the chart 

corner with your mouse, you can resize the chart. 

 

Select the 

border to 

resize or move 

the chart 

Select the chart 

area to separate 

the chart 
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To move the chart, let your mouse pointer hover over any border. When you see 

your mouse pointer turn into a cross with four arrows, you will be able to move 

the chart around your screen by holding the left mouse button down and 

dragging. 

If you want to make a chart an object in another worksheet, or move the chart to 

a sheet of its own, do the following. 

 Right-click on the chart 

 Choose Move Chart from the drop down menu 

 Select New Sheet or a different sheet from the Object in: dropdown arrow 

 Click OK 

 

Note that you can also click the Move Chart button in the Design Ribbon to 

display the Move Chart dialogue box. 

 

To remove a chart from your worksheet: 

 Click in the chart area 

 Press the Backspace or Delete key on your keyboard. 
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Adding a chart title 

To add a chart title: 

 Click on the + symbol to the right of the chart 

 Select Chart Title 

Or from the design tab you can use the Add Chart Element Option (as below); 

 

Adding a chart Axis title 

Click anywhere in the chart to which you want to add axis titles. 

Click the Chart Elements button  next 

to the upper-right corner of the chart. 

Check the Axis Titles box. 

Primary horizontal and vertical axis titles are 

added to the chart. 

If your chart is a 3-D chart, or if it has 

secondary horizontal or vertical axes, click 

the arrow next to Axis Titles, and then 
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click More Options to select the depth or secondary axis titles you want to add. 

Click each Axis Title box that appears in the chart, and then type the text that 

you want. 

To start a new line in the title, press Shift+Enter. 

To format the axis titles, right-click them, and then click Format Axis Title to 

choose the formatting options you want. 

Changing the Type of Chart 

To change the chart type: 

 Click in the chart area to display the Chart Tools contextual tab 

 Select the Design tab 

 Click the Change Chart Type button 

 Select the new chart type and click OK or 

 Right-click on the chart area and selecting Change Chart Type from the 

drop down menu that appears. 
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You can also display the Change Chart Type dialogue box by right-clicking the 

Plot area 

Formatting a Chart 
Even after you create a chart, you can still alter its appearance. You can change 

how a chart looks by: 

 Selecting the chart area and selecting the Design tab or 

 Selecting an object in the chart area then right-click and select Format 

[Object name] from the menu 

Recommended Charts 
This new feature of Excel recommends charts using the Quick Preview feature. 

You can then select the most appropriate chart. 

Quick Analysis Option 
The Charts option in the Quick Analysis gallery allows the user to quickly view 

and analyse data by choosing a variety of chart types.  
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Chart formatting control 
Excel includes a more interactive way to customise charts. 

Once a chart is created select Chart Elements (+) for quick and easy editing of 

elements such as the chart title, legend and gridlines. 

Selecting the filter funnel is used to chart specific data points. Click on the Design 

tab to change the chart type.  

 

New Chart Types in Excel 2016 

On the Insert tab there are several new Chart Types available only in Excel 2016. 

Waterfall, Box & Whisker, Treemap, Sunburst, Histogram & Pareto 

 

Waterfall 
Being able to create a Waterfall chart with one click will amaze anyone who has 

attempted to create such a chart in previous versions of Excel. It would have 
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involved a lengthy work around using formulas, recolouring bars, white box and 

adjusting the scale. 

A Waterfall Chart, sometimes called a ‘flying brick chart’ is a way of visualizing a 

series of positive and negative data such as monthly cash flows. The bars appear 

to fly or float between the start and end columns giving the impression of a 

waterfall or a bridge. 

Suppose you have the following data and wish to display it in a Waterfall Chart: 

With Excel 2016 you click in the data and choose Insert, Waterfall from the 

Waterfall and Stock Chart button. 

Some formatting is needed but most of the work is done. 

Treemap 
This is a brand new chart type and a great way to visualize hierarchies of data. 

Suppose you have PivotTable data based on car sales. A Treemap can’t be created 

directly from a PivotTable so you will have to copy as values to another location. 

Now click in the data and choose 

Insert, Hierarchy Chart, 

Treemap 

 

http://i1.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/Waterfall1.png
http://i0.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/Treemap3.png
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Sunburst 
Another way to display this type of data is with a Sunburst chart. 

 

Box & Whisker 

The Box & Whisker chart is used to show statistical information about a set of 

data. The line in the middle indicates the median value (middle value) while the 

bottom and top of the boxes represent the spread of the data from the first to 

the third quartile (25thpercentile to the 75thpercentile). The lines extending 

vertically (whiskers) shows the spread of data outside this range. 

Histogram 
From the same data you can now easily create a Histogram chart. 

http://i2.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/Sunburst.png
http://i1.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/Box1.png


www.MicrosoftTraining.net              0207 987 3777                                          43 

 Right clicking on the axis and choosing Format Axis allow you to change the 

number of bars (bins) or the bin width. 

 

Pareto Chart 
A Pareto chart displays a series of figures as a combination of a cumulative line 

chart and columns chart sorted in descending order. 

Pareto Sorts your Bars: Highest first. This highlights which Bars have the biggest 

impact/return. This will influence your decision on where to assign your resources. 

To create a Pareto chart, click in the data and select 

Insert, Recommended Charts, Pareto 

 

  

http://i0.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/Pareto.png
http://i1.wp.com/www.microsofttraining.net/b/wp-content/uploads/2015/06/histogram.png
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 Unit 8: Working With Sparklines 

In this section you will learn how to: 

 Create a Sparkline in Excel 

 Modify Sparklines 

 Format Sparklines 

What are Sparklines? 
New in Microsoft Excel, a sparkline is a tiny chart in a worksheet cell that provides 

a visual representation of data. Use sparklines to show trends in a series of values, 

such as seasonal increases or decreases, economic cycles, or to highlight 

maximum and minimum values. Position a sparkline near its data for greatest 

impact. 
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Sparklines help bring meaning and context to numbers being reported and, 

unlike a chart, are meant to be embedded into what they are describing: 

In the above example, the sales number alone gives you a single moment in time, 

but adding sparklines in the table, next to the numbers it’s describing, gives 

history and shows a pattern of sales. The sparklines aren’t floating on the grid of 

Excel like a chart does. They aren’t rows, column, or sheets away from the data. 

They are in the table giving context to the numbers, unobtrusively, and appear 

like text in the cell. 

Create a Sparkline 

1. Select an empty cell or group of empty cells in which you want to insert one 

or more sparklines. 

2. On the Insert tab, in the Sparklines group, click the type of sparkline that 

you want to create: Line, Column, or Win/Loss. 

 

3. In the Data box, type the range of the cells that contain the data on which 

you want to base the sparklines. 

Note You can click to temporarily collapse the dialog box, select the 

range of cells that you want on the worksheet, and then click to restore 

the dialog box to its normal size. 

Modify a Sparkline 

When one or more sparklines are selected, the Sparkline Tools appear, 

displaying the Design tab. On the Design tab, you can choose one or more of 

several commands from among the following groups: Sparkline, Type, 

Show/Hide, Style, and Group. Use these commands to create a new sparkline, 

change its type, format it, show or hide data points on a line sparkline, or format 

the vertical axis in a sparkline group. 

Use the Style gallery on Design tab, which becomes available when you select a 

cell that contains a sparkline. 

1. Select a single sparkline or a sparkline group. 
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2. To apply a predefined style, on the Design tab, in the Style group, click a 

style or click the arrow at the lower right corner of the box to see additional 

styles. 

 

3. To apply specific formatting to a sparkline, use the Sparkline Colour or the 

Marker Colour commands. 

Customize sparklines 

After you create sparklines, you can control which value points are shown (such 

as the high, low, first, last, or any negative values), change the type of the 

sparkline (Line, Column, or Win/Loss), apply styles from a gallery or set individual 

formatting options, set options on the vertical axis, and control how empty or 

zero values are shown in the sparkline. 

Control Which Value Points Are Shown 

You can highlight individual data markers (values) in a line sparkline by making 

some or all of the markers visible. 

 

In this sparkline, the high value marker is green, and the low value marker is 

orange. All other markers are shown in black. 

 To show all values, select the Markers check box. 

 To show negative values, select the Negative Points check box. 

 To show the highest or the lowest values, select the High Point or Low 

Point check boxes. 

 To show the first or the last values, select the First Point or Last Point check 

boxes. 
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Show or hide data markers 

On a sparkline that has the Line style, you can show data markers so that you can 

highlight individual values. 

1. Select a sparkline. 

2. In the Show/Hide group, on the Design tab, select any of the check boxes to 

show individual markers (such as high, low, negative, first, or last), or select 

the Markers check box to show all markers. 

Clearing a check box hides the specified marker or markers. 

Show and customize axis settings 

You can select Date Axis Type (in the 'Group' group, click Axis) to format the 

shape of the chart in a sparkline to reflect any irregular time periods in the 

underlying data. 

 

In a line sparkline, applying the Date Axis type can change the slope of a plotted 

line and the position of its data points in relation to each other. 

In a column sparkline, applying the Data Axis type can change the width of and 

increase or decrease the distance between the columns, as shown in the following 

image. 

 

In the example shown here, there are two column sparklines that use data from 

the same range. The sparkline with the “Trend” label uses the General Axis type, 

and the sparkline with the “Trend (Data Axis Type)” label uses the Date Axis type. 

In each sparkline, the first two data points are separated by two months, and the 

second and third are separated by seven months. By applying the Date Axis type, 

the space between the three columns changes proportionally to reflect the 

irregular time periods. 
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You can also use these Axis options to set minimum and maximum values for the 

vertical axis of a sparkline or sparkline group. Setting these values explicitly helps 

you control the scale so that the relationship between values is shown in a more 

meaningful way. 

1. With the sparkline or sparkline group selected, in the 'Group' group, click 

Axis. 

2. Under Vertical Axis Minimum Value Options or Vertical Axis Minimum 

Value Options, click Custom Value. 

3. Set minimum or maximum values that you feel will best emphasize the 

values in the sparklines. 

You can increase the height of the row that contains the sparkline to more 

dramatically emphasize the difference in data values if some is very small and 

some is very large. 

You can also use the Plot Data Right-to-Left option to change the direction in 

which data is plotted in a sparkline or sparkline group. 

 

If there are negative values in your data, you can emphasize this by showing a 

horizontal axis in your sparkline. 

1. With the sparkline or sparkline group selected, in the 'Group' group, click 

Axis. 

2. Under Horizontal Axis Options, click Show Axis. 

Any sparklines that contain negative data will display a horizontal axis at 0. 
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Handle Empty Cells Or Zero Values 

You can control how a sparkline handles empty cells in a range (and thus how the 

sparkline is displayed) by using the Hidden and Empty Cell Settings dialog box. 
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Quick reference: Excel shortcuts 

Key Description 

CTRL+SHIFT+( Unhides any hidden rows within the selection. 

CTRL+SHIFT+) Unhides any hidden columns within the selection. 

CTRL+SHIFT+& Applies the outline border to the selected cells. 

CTRL+SHIFT_ Removes the outline border from the selected cells. 

CTRL+SHIFT+~ Applies the General number format. 

CTRL+SHIFT+$ Applies the Currency format with two decimal places (negative 

numbers in parentheses). 

CTRL+SHIFT+% Applies the Percentage format with no decimal places. 

CTRL+SHIFT+^ Applies the Exponential number format with two decimal places. 

CTRL+SHIFT+# Applies the Date format with the day, month, and year. 

CTRL+SHIFT+@ Applies the Time format with the hour and minute, and AM or PM. 

CTRL+SHIFT+! Applies the Number format with two decimal places, thousands 

separator, and minus sign (-) for negative values. 

CTRL+SHIFT+* Selects the current region around the active cell (the data area 

enclosed by blank rows and blank columns). 

In a PivotTable, it selects the entire PivotTable report. 

CTRL+SHIFT+: Enters the current time. 

CTRL+SHIFT+" Copies the value from the cell above the active cell into the cell or 

the Formula Bar. 

CTRL+SHIFT+ + Displays the Insert dialogue box to insert blank cells. 

CTRL+Minus (-) Displays the Delete dialogue box to delete the selected cells. 

CTRL+; Enters the current date. 

CTRL+` Alternates between displaying cell values and displaying formulas 

in the worksheet. 

CTRL+' Copies a formula from the cell above the active cell into the cell or 

the Formula Bar. 

CTRL+1 Displays the Format Cells dialogue box. 
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CTRL+2 Applies or removes bold formatting. 

CTRL+3 Applies or removes italic formatting. 

CTRL+4 Applies or removes underlining. 

CTRL+5 Applies or removes strikethrough. 

CTRL+6 Alternates between hiding objects, displaying objects, and 

displaying placeholders for objects. 

CTRL+8 Displays or hides the outline symbols. 

CTRL+9 Hides the selected rows. 

CTRL+0 Hides the selected columns. 

CTRL+A Selects the entire worksheet.  

If the worksheet contains data, CTRL+A selects the current region. 

Pressing CTRL+A a second time selects the current region and its 

summary rows. Pressing CTRL+A a third time selects the entire 

worksheet. 

When the insertion point is to the right of a function name in a 

formula, displays the Function Arguments dialogue box. 

CTRL+SHIFT+A inserts the argument names and parentheses when 

the insertion point is to the right of a function name in a formula. 

CTRL+B Applies or removes bold formatting. 

CTRL+C Copies the selected cells.  

CTRL+C followed by another CTRL+C displays the Clipboard. 

CTRL+D Uses the Fill Down command to copy the contents and format of 

the topmost cell of a selected range into the cells below. 

CTRL+F Displays the Find and Replace dialogue box, with the Find tab 

selected.  

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last 

Find action. 

CTRL+SHIFT+F opens the Format Cells dialogue box with the Font 

tab selected. 

CTRL+G  Displays the Go To dialogue box.  

F5 also displays this dialogue box. 
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CTRL+H  Displays the Find and Replace dialogue box, with the Replace tab 

selected. 

CTRL+I Applies or removes italic formatting. 

CTRL+K Displays the Insert Hyperlink dialogue box for new hyperlinks or the 

Edit Hyperlink dialogue box for selected existing hyperlinks. 

CTRL+N  Creates a new, blank workbook. 

CTRL+O  Displays the Open dialogue box to open or find a file. 

CTRL+SHIFT+O selects all cells that contain comments. 

CTRL+P Displays the Print dialogue box. 

CTRL+SHIFT+P opens the Format Cells dialogue box with the Font 

tab selected. 

CTRL+R Uses the Fill Right command to copy the contents and format of 

the leftmost cell of a selected range into the cells to the right. 

CTRL+S Saves the active file with its current file name, location, and file 

format. 

CTRL+T Displays the Create Table dialogue box. 

CTRL+U Applies or removes underlining. 

CTRL+SHIFT+U switches between expanding and collapsing of the 

formula bar.  

CTRL+V  Inserts the contents of the Clipboard at the insertion point and 

replaces any selection. Available only after you have cut or copied 

an object, text, or cell contents. 

CTRL+ALT+V displays the Paste Special dialogue box. Available 

only after you have cut or copied an object, text, or cell contents on 

a worksheet or in another program. 

CTRL+W Closes the selected workbook window. 

CTRL+X  Cuts the selected cells. 

CTRL+Y Repeats the last command or action, if possible. 

CTRL+Z Uses the Undo command to reverse the last command or to delete 

the last entry that you typed. 

 

  



www.MicrosoftTraining.net              0207 987 3777                                          53 

  

KEY DESCRIPTION 

F1 Displays the Microsoft Office Excel Help task pane. 

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft 

Office Fluent user interface. 

ALT+F1 creates a chart of the data in the current range. 

ALT+SHIFT+F1 inserts a new worksheet. 

F2 Edits the active cell and positions the insertion point at the end of the 

cell contents. It also moves the insertion point into the Formula Bar 

when editing in a cell is turned off. 

SHIFT+F2 adds or edits a cell comment. 

CTRL+F2 displays the Print Preview window. 

F3 Displays the Paste Name dialogue box. 

SHIFT+F3 displays the Insert Function dialogue box. 

F4 Repeats the last command or action, if possible. 

CTRL+F4 closes the selected workbook window. 

F5 Displays the Go To dialogue box. 

CTRL+F5 restores the window size of the selected workbook window. 

F6 Switches between the worksheet, Ribbon, task pane, and Zoom 

controls. In a worksheet that has been split (View menu, Manage This 

Window, Freeze Panes, Split Window command), F6 includes the split 

panes when switching between panes and the Ribbon area.  

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, 

and Ribbon. 

CTRL+F6 switches to the next workbook window when more than one 

workbook window is open. 

F7 Displays the Spelling dialogue box to check spelling in the active 

worksheet or selected range. 

CTRL+F7 performs the Move command on the workbook window when 

it is not maximized. Use the arrow keys to move the window, and when 

finished press ENTER, or ESC to cancel. 
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F8 Turns extend mode on or off. In extend mode, Extended Selection 

appears in the status line, and the arrow keys extend the selection. 

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection 

of cells by using the arrow keys. 

CTRL+F8 performs the Size command (on the Control menu for the 

workbook window) when a workbook is not maximized. 

ALT+F8 displays the Macro dialogue box to create, run, edit, or delete 

a macro. 

F9 Calculates all worksheets in all open workbooks. 

SHIFT+F9 calculates the active worksheet. 

CTRL+ALT+F9 calculates all worksheets in all open workbooks, 

regardless of whether they have changed since the last calculation. 

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then 

calculates all cells in all open workbooks, including cells not marked as 

needing to be calculated. 

CTRL+F9 minimizes a workbook window to an icon. 

F10 Turns key tips on or off. 

SHIFT+F10 displays the shortcut menu for a selected item. 

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more 

than one smart tag is present, it switches to the next smart tag and 

displays its menu or message. 

CTRL+F10 maximizes or restores the selected workbook window. 

F11 Creates a chart of the data in the current range. 

SHIFT+F11 inserts a new worksheet. 

ALT+F11 opens the Microsoft Visual Basic Editor, in which you can 

create a macro by using Visual Basic for Applications (VBA). 

F12 Displays the Save As dialogue box. 

Key Description 

ARROW 

KEYS 

Move one cell up, down, left, or right in a worksheet.  

CTRL+ARROW KEY moves to the edge of the current data region (data 

region: A range of cells that contains data and that is bounded by empty 

cells or datasheet borders.) in a worksheet. 
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SHIFT+ARROW KEY extends the selection of cells by one cell. 

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last 

nonblank cell in the same column or row as the active cell, or if the next 

cell is blank, extends the selection to the next nonblank cell. 

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when 

the Ribbon is selected. When a submenu is open or selected, these 

arrow keys switch between the main menu and the submenu. When a 

Ribbon tab is selected, these keys navigate the tab buttons. 

DOWN ARROW or UP ARROW selects the next or previous command 

when a menu or submenu is open. When a Ribbon tab is selected, these 

keys navigate up or down the tab group. 

In a dialogue box, arrow keys move between options in an open drop-

down list, or between options in a group of options. 

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down 

list. 

BACKSPACE Deletes one character to the left in the Formula Bar. 

Also clears the content of the active cell. 

In cell editing mode, it deletes the character to the left of the insertion 

point. 

DELETE Removes the cell contents (data and formulas) from selected cells 

without affecting cell formats or comments.  

In cell editing mode, it deletes the character to the right of the insertion 

point.  

END Moves to the cell in the lower-right corner of the window when SCROLL 

LOCK is turned on. 

Also selects the last command on the menu when a menu or submenu 

is visible. 

CTRL+END moves to the last cell on a worksheet, in the lowest used 

row of the rightmost used column. If the cursor is in the formula bar, 

CTRL+END moves the cursor to the end of the text.  

CTRL+SHIFT+END extends the selection of cells to the last used cell on 

the worksheet (lower-right corner). If the cursor is in the formula bar, 

CTRL+SHIFT+END selects all text in the formula bar from the cursor 

position to the end—this does not affect the height of the formula bar.  

ENTER Completes a cell entry from the cell or the Formula Bar, and selects the 

cell below (by default). 
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In a data form, it moves to the first field in the next record. 

Opens a selected menu (press F10 to activate the menu bar) or performs 

the action for a selected command. 

In a dialogue box, it performs the action for the default command 

button in the dialogue box (the button with the bold outline, often the 

OK button). 

ALT+ENTER starts a new line in the same cell. 

CTRL+ENTER fills the selected cell range with the current entry. 

SHIFT+ENTER completes a cell entry and selects the cell above. 

ESC Cancels an entry in the cell or Formula Bar.  

Closes an open menu or submenu, dialogue box, or message window. 

It also closes full screen mode when this mode has been applied, and 

returns to normal screen mode to display the Ribbon and status bar 

again. 

HOME Moves to the beginning of a row in a worksheet. 

Moves to the cell in the upper-left corner of the window when SCROLL 

LOCK is turned on. 

Selects the first command on the menu when a menu or submenu is 

visible. 

CTRL+HOME moves to the beginning of a worksheet. 

CTRL+SHIFT+HOME extends the selection of cells to the beginning of 

the worksheet. 

PAGE 

DOWN 

Moves one screen down in a worksheet.  

ALT+PAGE DOWN moves one screen to the right in a worksheet. 

CTRL+PAGE DOWN moves to the next sheet in a workbook. 

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a 

workbook. 

PAGE UP Moves one screen up in a worksheet. 

ALT+PAGE UP moves one screen to the left in a worksheet. 

CTRL+PAGE UP moves to the previous sheet in a workbook. 

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a 

workbook. 
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SPACEBAR In a dialogue box, performs the action for the selected button, or selects 

or clears a check box. 

CTRL+SPACEBAR selects an entire column in a worksheet. 

SHIFT+SPACEBAR selects an entire row in a worksheet. 

CTRL+SHIFT+SPACEBAR selects the entire worksheet.  

 If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the 

current region. Pressing CTRL+SHIFT+SPACEBAR a second time selects 

the current region and its summary rows. Pressing 

CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet.  

 When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects 

on a worksheet. 

ALT+SPACEBAR displays the Control menu for the Microsoft Office 

Excel window. 

TAB Moves one cell to the right in a worksheet. 

Moves between unlocked cells in a protected worksheet. 

Moves to the next option or option group in a dialogue box. 

SHIFT+TAB moves to the previous cell in a worksheet or the previous 

option in a dialogue box. 

CTRL+TAB switches to the next tab in dialogue box. 

CTRL+SHIFT+TAB switches to the previous tab in a dialogue box. 

 

 

 

 

 

 

E&OE 

STL Training reserves the right to revise this publication and make changes from 

time to time in its content without notice. 
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